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A conservation plan for British Columbia, Canada 
 

Your mission is to identify cost-effective areas for conservation as marine protected 
areas that will protect biodiversity in the Pacific Ocean between Hakai Pass and Port 
Hardy to the edge of the continental shelf, British Columbia, Canada. The biodiversity 
features that you will use are the 55 major benthic classes and 4 habitat types. 

 
First, you will construct the data files necessary to perform a conservation planning 
analysis using the software Marxan. To make these files, you will use spatial data on the 
distribution of biodiversity and cost. Once you have built all the data files, this is your 
chance to explore some of the challenges of conservation planning. Although this is 
laborious, it’s essential that you know from first principles how such data files are put 
together. Only through this process will you really understand what the Marxan software 
is doing.  

 
Throughout this prac, you can refer to the excellent Marxan and Zonae Cogito manuals, 
which are available in the folder that you will download from the dropbox to your 
student space. Familiarise yourself with these manuals – they contain many answers to 
questions you may have. 
 

➢ First, create a home folder and make sure it has a short file name (less 
than 9 characters) and contains no spaces or other strange characters 
such as question marks or ampersands. This is vitally important. Copy 
the entire folder “Prac_CONS7021_2020” from the dropbox folder: 
https://www.dropbox.com/sh/0l4h1g4916qei9o/AADIEz84pZer0T1_Na8E
LM7da?dl=0  to your desktop. 

 

➢ Navigate to your Home folder in the student space and double click in the 
folder “Case_Study”, then double click on “IntroMarxan.mxd” to launch a 
project in the GIS software ArcMap. Take a deep breath and don’t panic. 

➢ Throughout this prac manual, when you see a path to a filename (as in the 
screenshots below), you won’t necessarily type this in exactly. Rather, you 
must decide where and how to organize your own folders and files within 
your home folder– all file names given here are suggestions only, if another 
name will be easier for you to work with, then by all means use that, but 
keep them all short and avoid weird characters and spaces. You will 
generate a lot of files during this prac series, so periodically tidy up and keep 
organized. 

➢ Ensure the Spatial Analyst extension is enabled by clicking on Customise, 
Extensions, then enabling Spatial Analyst by checking its box. You’ll have to 
perform this step at the start of each prac. 
 

➢ You may have to repair the data source if you see a red exclamation sign (!) next to 
each data layer. Just go to Case_Study and click on BC_Ocean. 

➢ Explore each data layer so that you have a better understanding of the type of 
information that you will be working with in this course. If needed, confer with 
your tutor about how to operate and explore the data spatially, and see below. 
Basically, you just tick and untick the different layers to look at them. 

  

https://www.dropbox.com/sh/0l4h1g4916qei9o/AADIEz84pZer0T1_Na8ELM7da?dl=0
https://www.dropbox.com/sh/0l4h1g4916qei9o/AADIEz84pZer0T1_Na8ELM7da?dl=0
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The data layers, listed on the left hand side of the screen are: 

 
• BC_Ocean: The marine study region, constituting British Columbia, Canada 

 
• Vessel_cost2: Vessel movement data (including fishing, carrier, ferry, tug, oil 

tankers, and cruise ships) that represents the cost to industry if 
the planning units where included in a network of marine 
protected areas. These cost values were extracted based on the 
square root of the number of vessel counts in a cell and then 
reclassified in four classes 
 

• Benthic_BC: A group of 55 benthic classes in British Columbia. The benthic 
classification is based on depth class, substrate, and slope. Each 
benthic class will be considered as one conservation feature 

 
 

• Habitats Four habitat  types showing distribution for sponge reefs, bull kelp, 
giant kelp, and general kelp distribution for BC 

 

Data sources used in this prac series 
 

It is important to cite your data sources when writing reports or papers based on 
analyses of existing datasets. The appropriate references for the data used in this prac 
series are below. 

British Columbia Marine Conservation Analysis. 2011. Marine Atlas of Pacific Canada: a 
product of the British Columbia Marine Conservation Analysis (BCMCA) © British 
Columbia Marine Conservation Analysis, 2011  

 

Creating Marxan input files in ArcMap 

 
This process involves the creation of four files necessary to run Marxan. These are: 

 
1. pu.dat - this is a text file that describes each planning unit, the cost of selecting that unit and 

the selection status of that unit. 
 

2. spec.dat - this is another text file that describes the “species” or conservation features that 
you want to include in your analysis. This file contains the “species” id, the conservation 
target (proportion of conservation feature to protect), penalties for not meeting targets (SPF) 
and the descriptive names for each conservation features. 

 

3. puvsp.dat – this text file contains the amount of each “species” in each planning unit. 
 

4. bound.dat – this file describes the adjacency relationships between planning units and their 
shared boundary length. 

 
Step 1: Creating Marxan folders 
 
Before you begin preparing Marxan input files you need to create the folders required for 
Marxan. You can do that manually (very painful), but we will do it by using the ArcMarxan 
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tool, which you will also use later to create some of the input files.  Let’s add the ArcMap 
toolbox to ArcMap toolboxes.  
 

➢ Inside the “Case_Study” folder go to your arcmap_extensions folder 

➢ Click on Arcmarxan-1.1.win32. Click next three times and then click finish 

➢ Go to ArcToolbox and click. Then right click on ArcToolbox and select 

Add Toolbox 

➢ If your home folder does not appear, click on the 

connect folder (see image) and search for it.  

➢ Double click in “arcmap_extensions” select 
ArcMarxan.pyt, then click open 
 

➢ Go to ArcMarxan Toolbox (1.1)  

➢ Double click on Create Input File and Folders. 

Click on the browse button 

➢ Search for the “Marxan” folder and click ones and then click ADD 

➢ Click OK  

 
Well done! You have created three folders Marxan will need (input, output, and pu) 
and the input.dat file which will be the master mind behind Marxan. We will later talk 
about this folders and files.  

 
 
 
Step 2: Creating Planning Units 
 

Planning units refer to the grid and cell size that you will select among as potential protected 
areas 
 

The size of the planning units is determined by 
the scale of the analysis, the resolution of the 
data used, and the objective of the planning 
exercise. Planning units can be squares, 
hexagons, or irregular shape polygons. With help 
of GIS you will calculate the area within each 
planning unit covered by each conservation 
feature distribution and use these quantities to 
run a Marxan analysis. 

 
Next you will create a square grid for the British 
Columbia dataset with 2 x 2 km2 cells (2000 x 
2000 m2). Note that the GIS data for the study 
region are in units of meters. 
 

 

 

In this exercise you will learn how to create a planning unit layer using Create Fishnet 
from ArcMap toolbox. 
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• Step 2a: Creating Planning Units using Create Fishnet 
 

Note: there are many ways to create planning units – this is only one.  
 

➢ To make your ArcToolbox visible, click on red toolbox button  

➢ Click on Data Management Tools in the ArcMap 
toolbox 

➢ Click on Sampling 

➢ Double click on Create Fishnet 

➢ Click on Output Feature Class browse button  

➢ Double click on folder “DataPrep”, in name write 
“gridpulayer” (you can choose another name). 
Save as type should be “Feature Class”. Click Save  

➢ In Template Extent select “Same as layer 
Study_Region_BC_Ocean” 

➢ Write 2000 in Cell Size Width and in Cell Size 
Height 

➢ Deselect Create Label Point 

➢ In Geometry Type select Polygon 
 

➢ Click OK. Ensure your “Create Fishnet” window has the parameters shown in the 
figure to the right 

 
Note: As you are creating tables, exporting layers, and preparing data needed to create the 
final Marxan input files, you will save them in the “DataPrep” folder. 
 

• Step 2b: Limiting the planning units to your study region 
 

Because we are only considering those planning units that intersect with the ocean and not 
the land, we are going to perform a selection to only select the planning units that intersect 
with the layer Study_Region_BC_Ocean, and later export that selection to create a new 
shapefile of planning units. 
 

➢ In the main menu, choose “Selection,” then “Select by Location” 

➢ In the first drop down box, choose “select features from” (Selection method) 

➢ In “Target layer” tick the box next to “gridpulayer”  

➢ In “Source layer” choose the “Study_Region_BC_Ocean”  

➢ In “Spatial selection method…” Choose the "intersect the source layer feature"  

➢ Click “APPLY” 

 

You can see that the planning units that intersect the Study_Region_BC_Ocean layer are 
selected (now highlighted in blue). Now you will create a new shapefile only using these 
planning units. 
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➢ Right click on “gridpulayer” 

➢ Choose “Data”, then “Export Data” 

➢ Click on the browse button to select “DataPrep” 
folder. Here you will export your intersected 
planning units 

➢ In Name type the name of your planning units (your 
choice), such as “pulayer”. In Save as type, select 
Shapefile. Click Save. 

➢ Click “OK” 

➢ Click “yes” to add the exported data to the map as a 
layer 

➢ Choose “Selection” from the main menu, then “Clear Selected Features” 
 

If you cannot see your new layer, turn off the gridpulayer layer, and you should be able to 
view “pulayer”. 

 

➢ Step 2c: Creating planning unit unique ID field 
 

Marxan requires each planning unit to have a unique identifier or “planning unit id” or 
“puid”. In this step you will assign a unique ID to each planning unit. 
 

➢ Right click on “pulayer” then select “Open Attribute Table” 

➢ Click “Table Options” (top-left corner of the table) then “Add field” 

➢ Select “Long Integer” as the “Type” 

➢ Name the field “PUID” and click “OK” 

➢ Left click on the column title “PUID” and then right click, click “Field Calculator”. In the 

pop-up message, click Yes 

➢ Under “Fields,” double-click on “FID” (so it appears in the calculation box), then on the 
“+” sign (on right hand side of window) then type in the number 1, and then Click “OK”. 
This assigns a unique ID to each planning unit, starting with 1 instead of 0 
 

➢ “Id” field is unnecessary, delete it by right clicking on “Id” and select "Delete Field" 

➢ Close the table 

 

You need the planning unit shapefile to run Zonae Cogito (Day 2). You will need to export 
your pulayer to the “pu” folder in the “Marxan” folder. Right click on your pulayer and go to 
“Data” then click on “Export Data”. Browse for your “pu” folder, double click, and then in 
name write pulayer. Make sure Shapefile is selected in the Save as type scroll down. Click 
Save, then OK. In the pop-up message say NO.   

 
Well done! Now you have created your planning unit shapefile. This will be used to 
create the files: pu.dat, puvsp.dat and bound.dat. It will be also used by Zonae Cogito 
(Day 2) to visualize Marxan results 
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Step 3: Creating the planning unit file (pu.dat) 
 
Now you will be creating the pu.dat file that contains the planning unit id, cost (cost of each 
planning unit), and status (availability for selection). 
 

• Step 3a: Creating cost table 
 

We have provided a GIS layer of vessel movement values to represent cost to industry if a 
planning unit is allocated to a marine protected area network. Here, the value for cost is high 
if there are many vessels moving through that planning unit (e.g. class 4), and lower 
elsewhere (e.g. class 1). You will calculate the expected cost of selecting each planning unit 
assuming that by selecting a planning unit for reservation you are removing vessel access. 
Think, does this cost layer make sense?  
 
Note: Please ensure that the tables for your layers “pulayer” and “Vessel_cost” do not have any 
rows selected or the “Zonal Statistics” function will not work correctly  
 
➢ Go to your Toolbox. Under “Spatial Analyst Tools” click on “Zonal” then “Zonal Statistics 

as Table” 
 

➢ Select pulayer as the input feature, and PUID in Zone field 
 
➢ Select input vessel_cost2 in the input 

value raster 
 

➢ In the “Output table” browse button 
search for your “DataPrep” folder and 
type on the Name: ZonalCost (or a 
name you like). Click Save 

 
➢ In “Statistics Type” select "SUM"  

 
➢ Ensure your “Zonal Statistics as 

Table” window has the parameters shown in the figure to the right. Click “OK” 
 
 

Well done! This will create a table (ZonalCost) that sums the vessel value (cost to 
industry) contained in each planning unit (indexed by PUID). Explore the table.  
 

• Step 3b: Link planning unit with cost 
 

Note: If you cannot see the table in ArcMap, you can manually add it to ArcMap. Click on the 

yellow sign  and search for it. 
 
First you will create a new “cost” column in your pulayer 
 

➢ Right click on your “pulayer” and open attribute table 
 

➢ Click top left and click on Add field. Name as “cost”, in Type “Long Integer”. Click Ok  
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Next you will join cost data with your player 
 

➢ First, right click on “pulayer” and select “Joins 
and Relates” and then “Join”. In the first drop 
menu select the field “PUID”, in the second the 
table “ZonalCost”, and in the third select the 
field “PUID”.  

 

➢ Ensure your Join window has the following 
parameters shown in the figure.  

 
➢ Click OK. In the pop-up message click Yes 

 
Finally, you will assign the cost data to your 
recently created “cost” column 

 
➢ Right click on your pulayer and open attribute 

table. Right click in the column title “cost” and 
click “Field Calculator”. Click Yes to the pop-up message. Next double click on 
“zonalcost:SUM” from the Field drop scroll. Click Ok 
 

➢ You should now see your cost column with the cost data. Compare it with the SUM 
column, it should have the same values 

 

➢ Finally, you can remove the join by: right click on your pulayer and in Joins and 
Relates go to Remove Join(s) and select Remove All Joins 

 
Well done! Now the pulayer has a new column with the cost values for each planning 
unit, but you need to put this information into a format that Marxan can use.  
 

• Step 3c: Setting the planning units status 
 
In Marxan, currently protected areas can be locked into the solution set to reflect that they 
are unlikely to be changed or moved. To do this, the planning unit status must be assigned a 
“2” in the planning unit file (a status of “0” is available; “3” is locked out; “2” is locked 
in). You will have the opportunity to lock planning units in or out of solutions in Day 2. You 
will now assign the status to all planning units by giving them a status of “0”, that is you will 
leave them all available for selection. 
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➢ Right click on your “pulayer” and open 
attribute table 
 

➢ Click top left and click on Add field. Name as 
“status”, in Type “Long Integer”. Click Ok  

➢ Right click on the column title “status” and 
click “Field Calculator” 
 

➢ Right click on the column title “status” and 
click “Field Calculator”. Next type 0 under 
status. Click Ok 

 

You just added the status column to your 
planning unit file.  
 
 
 

• Step 3c: Export data to create planning unit file 
 

You have now linked your planning units (PUID) with cost using the Join Data tool and 
created a column to assign the status of your planning unit.  Now you need to export this 
data in the format that Marxan requires, a txt file. 
 

➢ Click on MarxanToolbox and select Export Planning Unit File 
 

➢ In Planning unit layer select your 
“pulayer” 

 

➢ In Planning unit id field select 
“PUID” 

 

➢ In the Planning unit cost field select 
“cost” 

 

➢ In the Planning unit status field select “status” 
 

➢ In Marxan input folder search for your Marxan/input folder 
 

➢ Click on your “input” folder. Click Add. Then Click OK 
 

➢ Check your input folder, you should have a pu.dat. Open it and 
explore 

 

 

 

Well done! You just created the first Marxan input file, the pu.dat.  
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Step 4: Creating the planning unit versus species matrix 
(puvsp.dat) 
 
In this exercise, you will determine how much of each of the conservation features (benthic 
classes, sponge reef, and kelp) distribution is contained in each planning unit. 
 
Note: Each of the conservation features has been pre-assigned a unique identifier. There are 
many ways that this can be done using GIS software. These data were prepared by giving each 
conservation feature a unique id when it was in feature class shapefile format, then it was 
converted to raster using this id.  

 
• Step 4a: Calculate area in each planning unit covered by each benthic 

class 
 
Note: Please ensure that the tables for your layers “pulayer” and “benthic_bc” do not have any 
rows selected or the tabulate areas function will not work correctly. 
 
➢ In ArcMap, right click on “pulayer”, select “Joins and Relate” then “Remove Joins” then “Remove 

All Joins”  

➢ Go to your Tool Box. Under Spatial Analyst Tools, Zonal, click on “Tabulate Area” 
 

 
Here you are calculating how much of each habitat type is in each planning unit. The first 
drop down box,  “Input raster or feature zone data” is your planning unit layer, that you will 
use to calculate the area of each feature found in each “Zone Field” (second drop down box), 
your planning unit. The “Input raster or feature class data” for the third drop down box is 
the conservation feature dataset you want to calculate the amount of for each planning unit.  

 
➢ In Input feature zone data choose pulayer 

 

➢ Zone field: PUID 
 

➢ Input raster or feature class data: 
benthic_bc. Class field: Value 

 

➢ In the Output table click the browse 

button  and select your DataPrep 
folder. Name the output table “Benthic” 
(or as you like), then click “Save” and then 
“OK” 

➢ Ensure your Tabulate Area window looks like the image. 02-cost-vocc_feat-sps_ssp245 
 

Explore the Benthic table. What do you see?  
 

 

 

 

 

 

• Step 4b: Calculate area in each planning unit for remaining 

conservation features  
Repeat the tabulate area steps above for the remaining conservation feature (one by one!) 
datasets to calculate how much of each of the conservation features is contained in each 
planning unit. Make sure you do that in order, from feature 56, 57, 58, and 59, this is very 
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important! Name the tabulate area files something that makes sense for each feature (for 
example, TabulateSponge56, TabulateBullKelp57….).  
 
Note: there are better ways to do this. Image you are working with a thousand species, it 
would be a lot of work to do it one by one. This is when we use programming tools like R! 
 
 

• Step 4c: Join tables to your pulayer 
 

➢ Ensure that all tables are added to ArcMap 

 

➢ If you cannot see the tables in ArcMap, you will 
need to select the “List by Source” tab from the 
ArcMap table of contents 
 

➢ Right click on your pulayer and go to “Joins and 
Relates” then click “Join”. In the first scroll option 
“Choose the filed” select PUID. Then In the next 
scroll down select TabulateBenthic, and in the third 
PUID. Click “Yes” to the pop-up message, Click OK.  
 

➢ Check your player attribute table. You should have 
the area in each PUID for 55 benthic classes 
 

➢ Repeat the join for the remaining conservation features. It is very important you do this 
in order. Begin by feature 56 
(TabulateSponge56), then 57 
(TabulateBullKelp57), 58 
(TabulateGiantKelp58), and 59 
(TabulateGenKelp59). If you don’t do 
this you will mismatch the identifier of 
each feature. Very important! 
 

➢ Check that your have 59 “Value” columns 
in your player attribute table 

 

 

Finally, you will need to export your joint pulayer to create the puvsp.dat file.  
 
 

➢ Right click on your “pulayer”, go to Data and click on Export Data 

 

➢  Click the browse button. Go to “DataPrep” folder and in name write “pulayerfeatures” 
(or another name you like) in “Save as type” select “shapefile”. Click Yes to export data to 
the map as a layer  
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• Step 4d: Create the puvsp.dat 
 

Now you will use the ArcMarxan Toolbox 
to create your puvsp.dat.  

 
➢ Click on ArcMarxan Toolbox 

 

➢ Click on Export Feature File 
 

➢ Select in planning unit layer your 
“pulayerfeatures” 

 

➢ In Planning unit id field “PUID” 
 

➢ In features field select all and then 
turn off all boxes which are not 
features (you only want from 
VALUE_1 to Value_59). Very 
important, make sure you only select these  

 

➢ Click the browse button and select in “Marxan” 
the “input” folder to save 
 

➢ Click Add, then OK 
 

➢ Go to your input folder. You can see that apart 
from the puvsp.dat file, another three .dat files 
were created. You can erase the 
puvsp_sporder.dat file. This file is the same as 
the puvsp but the conservation features are in 
order. For this exercise we will use the 
puvsp.dat. 

 
 
Well done! You just created your puvsp.dat. This text file contains the amount of each 
“species” in each planning unit. Check that it was created in your marxan input file. 
Explore it. 
 

Step 5: Editing the species file (spec.dat) 
 
In the previous step you created the species file, spec.dat. This is called the "species file" 
because when Marxan was first created, all conservation features were individual species. 
Now we call them "conservation features", but the file that lists them and their targets is still 
called the species file or spec.dat. 
 
This file lists the conservation features (each with a unique identifier or "id") and the target 
amount for that conservation feature (in this case, as a proportion of the total in the region 
or "prop") to be included in the reserve system. The "spf" column refers to the species 
penalty factor (a penalty applied if targets are not met). You can also include the name of the 
conservation feature in the field "name" to help you keep track (many analyses will have 
hundreds of conservation features). 
 
Now, we need to edit the spec.dat using Excel. You will set a target of 30% protection of each 
conservation feature distribution using the “prop” field in the spec.dat file (i.e., 0.3 of the 
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total area calculated for that conservation feature).  
 
The ArcMap toolbox generated some unnecessary columns for this practical which you 
need to delete. 
 

➢ Go to your Marxan “input” folder. Open the spec.dat in Excel. If it opens with 
Notepad, close and right click on spec.dat, go to Open with and select Excel. You can 
also open excel and drag spec.dat. 

 
➢ Right click on target column and select Delete 

 

➢ Repeat the previous step for targetocc and delete 

 
The species file is the file in which you must set a target amount for each conservation feature 
to be included in the solution. We will set a target of 30% for each conservation feature by 
doing the following step: 

 
➢ Go to column prop type 0.3 in B2. In cell B2, double click the bottom right hand 

corner of the cell to automatically fill the “0.3” value down the entire column 
 
 

ArcMap toolbox generated for you the species penalty factor (spf) value and set it 
automatically to 1. Keep it like that for now, you will have a chance to change and play with 
this parameter in Day 2 
 

Finally, you can replace in the “name” column the “Values” for the names of each 
conservation feature. Knowing the name of each feature can be helpful when you are running 
the Marxan analysis. You need to go back to ArcMap and export the benthic_bc layer to copy 
the features names and paste them in the spec.dat.  
 

➢ In ArcMap right click on benthic_bc and open attribute table. Make sure nothing is 
selected in the attribute table 
 

➢ Click in the top left and select Export. Search for the DataPrep folder and name the 
table as “SpeciesName.dbf” (or as you like). In save as type select dBASE Table 

 
➢ Click Save and then OK 

 
➢ Go to the Species name.dbf table that you just created 

and open it in Excel 
 

➢ Click on the first feature and drag the selection to the 55 
benthic class names. Right click and copy selection 

 
➢ Go back to your spec.dat 

 
➢ Right click in the first “Value” under the name column 

and select Paste 
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➢ Use the find and replace function to replace all “–” with “_” (Marxan 

does not accept the “–” symbol); do the same with the “+” symbol, 
replacing with the word “plus” (you may need to untick “match entire 
cell contents” under “Options”) 

 

➢ You can manually type the name of the remaining 4 conservation 
features as they are shown in the figure. Make sure they follow the 
order (56, 57, 58, 59) 

 
➢ Finally save as a CSV (Comma delimited) and name “spec” 

 
Well done! Now you have edited the spec.dat, the file that tells Marxan the unique 
identifier for each of your conservation features, the name of your conservation 
features, the target you want to meet for each conservation feature (prop), and the 
species penalty factor (spf) value (that you will calibrate tomorrow).  
 

 
Step 6: Creating the bound.dat file 
 

The bound.dat file indicates the measured length of the shared boundaries between adjacent 
planning units. This parameter is essential for controlling the spatial compactness of the 
solutions. For example, as you can see in the image, Id1 indicates the PUID for one planning 
unit, and id2 is the PUID for an adjacent planning unit. The boundary is the measurement of 
the boundary between the two planning units. We will create the bound,dat file using the 
ArcMarxan toolbox. 
 
Note: if you look carefully you can see that id1 and id2 can have 
the same value. This means that a planning unit has one (or more) 
of its boundaries not adjacent to another planning unit.  
 

➢ Go to ArcToolbox and in ArcMarxan Toolbox select 
“Export Boundary File” 

 
➢ In the first drop box, for the Planning unit layer select 

pulayer. Make sure your pulayer has no joins 
 

➢ In the next drop box, select PUID 
 

➢ For the boundary method select 
Measured 

 
➢ Leave the Boundary treatment in Full 

Value 
 

➢ In Marxan input click on the browse 
button and go to your input folder 

 
➢ Click OK 

 
➢ Go to your input folder and check the 

“bound.dat” file  
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Finally, we need adjust some details with the input files. Go back to our “input” folder. Open 
pu.dat in Excel. Then save as, in name write pu, in save as type select “CSV (Comma 
delimited)”. Close excel. Then erase the pu.dat file. Now open the pu file with Notepad and 
go to save as. In file name write pu.dat , in Save as type select “All files”. Repeat the same for 
puvsp.dat and spec (previously you already saved spec as a CSV (Comma delimited), you can 
skip that step).  Erase all files which are not a .dat one. 

 

Well done! Your data preparation is done. Now you can start working with Marxan.  

 

Step 7: Editing the input file (input.dat) file 
 
Congratulations. You are done creating the data files with ArcMap and will now edit the input 
file for running Marxan, and organize the remaining required files into the standard format. 
 
The input.dat file is like a list of instructions for Marxan where you will indicate the name 
and location of your other input files and set several parameters. A detailed description of 
all the parameters that can be set in the input.dat is in the Marxan manual, which is in the 
documents section of your course folders. We will not cover all of these parameters in this 
course. Some of the parameters specified in this file will be set by you. These parameters are 
indicated in yellow in the example input.dat below. 
 

Compare your input.dat to this one. Are the parameters the same? 

 
➢ Find the BLM parameter BLM. Set this to 0.6. You usually 

would calibrate this parameter, but I did that for you! BLM 
stands for Boundary Length Modifier, and the higher the 
BLM, the more “clumped” your solutions will be 
 

➢ You should have the NUMREPS to 100. This is the number 
of solutions Marxan will find each time you run it. NUMREPS 
stands for number of repetitions 

 

➢ Make sure that the Input file and folder names match the 
names of your files 

 

➢ SCENNAME You will change this to help identify which 
scenario the results are from. For now, just leave it as 
“output” as we are not yet setting up a scenario 

 

➢ Delete the MATRIXSPORDERNAME puvsp_sporder.dat. We 
will not use it in this pract 

 
➢ Make sure the OUTPUTDIR (output directory folder name) 

matches the name of your output foder 
 
➢ Save 

 
 

As indicated above, you can change many other parameters using the input.dat file. To 
find out more, consult your Marxan manual.  Finally, save the changes to your input.dat 
in your Marxan_Database_Master folder 
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Step 8: Running Marxan for the first time 
 

After completing the input.dat file you are ready to run Marxan. 
 

➢ From the Marxan_Database_Master folder, double click on Marxan.exe to start 
running the program 

 
If you have created all the input files properly, you should see Marxan generating solutions 
(see screen below). If you see something else, consult with a tutor. Don’t panic, we’ll get you 
up and running quickly.    
 

 

 

 

 

 
 
 

Well done! You’ve successfully created your first Marxan 
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Step 9: Using Zonae Cogito to visualise your conservation 
plans 

 
We need a way of visualising the conservation plan that you have created. Zonae Cogito 
(ZC) is a freely available package designed to do this. 

 
What can you do with ZC? 
 

• Edit Marxan parameters and input files. 
• Run Marxan analyses. 
• Interactively view the results of Marxan analyses 
• Interactively make changes to Marxan solutions 
• Calibrate Marxan parameters 

 
See the ZC user manual for details (located in ‘PracCONS2071_2020”\ 
“Marxan_ZC_Manuals”). 

Creating a backup database 
 

Before creating a new ZC project it is good practice to create a backup copy of all of your 
work. This way if something happens or you make changes you want to roll back you’ll 
have a clean copy. Later, you will create 15 new folders to run ZC and Marxan for the 
scenario building. For now, we will just create one folder: 

 
• Step 9a: Creating a new ZC project 

 
Start Zonae Cogito (ZC) from the windows menu system like this: 

 
➢ Make a copy of your Marxan_Backup folder and call it, e.g. 

“Marxan_ZC_Test1 
 

➢ Start > All Programs > Zonae Cogito > Zonae Cogito 
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➢ From the ZC main menu select File > New Project to create a new ZC project. 
 
➢ Give your project a name e.g. “TestRun1” 

 
For now, it is alright to use any name, but when you begin to develop more complex scenarios 
it is important to develop a naming convention that allows you to easily identify the scenario. 
If you have many different scenarios, it is also good to keep a master list indicating the costs, 
targets, and other parameters for each scenario. 
 
➢ Tick the box next to “Include Marxan Database” and then use the browse button to 

navigate to and select the input.dat file in ‘Home folder’\Marxan_ZC _Test1 (you 
choose a folder structure that suits you, but keep it logical) 

 
We will not be including c-plan or eFlows databases, so you can leave these unchecked. 

 

➢ Use the browse button next to the “Locate 
GIS Layers for Display” window to navigate 
to the pulayer folder, and select the 
pulayer.shp 

 
➢ Confirm that the pulayer.shp is the file listed 

in the “Select Planning Unit Shapefile” drop 
down. 

 
➢ Select “PUID” from the drop-down menu next 

to “Select Planning Unit Key Field” 
 
➢ Click OK to generate the new ZC project. 

 
➢ Ignore the R error message if it appears 

 

➢ From the ZC main menu select File > New Project to create a new ZC project. 
 
➢ Give your project a name e.g. “TestRun1” 
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Resizing the ZC windows 
 

When you first open ZC, you will see two windows, the GIS display window and the 
Marxan window. You might also notice that ZC does not fill your entire desktop. 

 
➢ To resize ZC, double click on the maximize window 
 

➢ After maximizing, from the ZC menu select Window > Arrange side by side 
 

➢ You can also choose "Arrange top to bottom" instead if you need to (these window 
options might be called “horizontal” or “vertical”) 

 
It is possible that the GIS window in ZC is currently blank, or shows a map with blue 
shading. Don’t panic, either is fine. Whenever you create a new project, the GIS window 
will appear blank until you have run Marxan for the first time. At this point it is also a 
good idea to save the Marxan project you have just created. 

 

Saving a ZC project 

➢ To save the project, select File > Save from the main ZC menu. Save the ZC project in 
the Marxan_database_Test1 folder and call it Test1 to be consistent 

 
You will notice that whenever you create a new ZC project it will create a file projectx.zcp 
inside the Marxan_database folder (the Marxan_database_Test1 folder in this case). This file 
can also be used to reopen a scenario, but it is best if you save the scenario with a name that 
reminds you what the scenario is. After saving the scenario we are ready to run Marxan from 
ZC. 
 

Running Marxan from within ZC 

➢ To run Marxan, click “Run” in the Marxan Box 
 

After clicking run, you should see a process (see below). 

 

 

After the run is complete, your planning unit layer will appear in the GIS window. 

 
Viewing Marxan results 

➢ Results from an individual run can be displayed by selecting the run number from 
the drop down menu next to “Output to Map” in the GIS display 
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➢ From the main menu select, Marxan > View Output > Summary > Report. This will 
display the summary information for all runs. Look at the Missing Values field. This 
indicates how many of your conservation features do not meet their targets in that 
solution. Are your targets being met? 

 
➢ From the main menu select, Marxan > View Output > Best Solution > Report. This 

will open the target achievement report for the solution with the lowest objective 
function. Look through this file to see if your targets have been met in the “best” 
solution. If they are not, check the MPM field- this indicates how close the target is to 
being met (1=100% met, 0.99= 99% met, etc.) 

 

➢ There are some 
other outputs 
(e.g. graphs) you 
can explore here 
also 
 

➢ For more details, 
look in your 
Marxan and ZC 
manuals, which 
are in the 
Manuals folder 
within your BC 
folder. 
 

➢ If you need to plot your results, you can also extract the needed data following these 
steps. Go to your output folder click in output_log. If you scroll down to the end you will 
see a message that says best solution is run (a number). Then scroll up and look for the 
best solution (number), in the last row of that run you can see the “cost”, “Pus” (number 
of planning units selected), and the shortfalls (targeted area for the conservation 
features which was not met). Copy and paste those results in excel for each of your best 
solutions. Do that for your scenario pracs (page22) then you can create your plots in 
excel.  
 

➢ Note: Number of Pus selected allows you to calculate the area of the entire solution. Just 
multiple the number of Pus by 4, and you will have the area of the solution in Km2 
(remember our planning units are of 2X2 Km). 
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Calibrating the number of iterations and the BLM 
 
The key parameter we explored in this analysis the number of iterations and the boundary length 
modifier (BLM). You can calibrate these two parameters with Zonae Cogito (see ZC manual); however, 
it is a tedious task and sometimes challenging to follow. We developed a function in R that allows you to 

easily calibrate the number of iterations and the BLM (Arafeh-Dalmau & Brito-Morales in prep). You can 

see the code in this link (http://doi.org/10.5281/zenodo.3235937)  

 
➢ Number of Iterations (NUMITNS): In general, the number of iterations determines how 

close Marxan gets to the optimal solution (or at least a very good solution). The number 
should start high (e.g. 1 000 000) and then be increased (e.g. 10 million or more is commonly 
applied on large scale datasets) until there is no substantial improvement in the score as 
iterations continue to increase. However, an increase in the number of iterations comes with 
an increase in execution time. At some point, the extra time required by a higher number of 
iterations will have no substantial improvement in the solutions. Choose an acceptable trade-
off between solution efficiency (cost, perimeter, or overall score) and execution time (number 
of iterations). Also, increasing the number of iterations decreases the variability across 
solutions, this enables more exploration of the searchable space within each run so that 
solutions became more similar as they get closer to optimality (decreases variability and the 
cost, perimeter, and fragmentation of the solutions). 

 
 

 
 
Trade-off curve for the cost and perimeter for three different iteration values (106, 107, 108). Each 
coloured curve represents 10 BLM scenarios with 10 runs each. In this example used to calibrate 
the number of iterations for the British Columbia case study, you can see how an increase in the 
number of iterations decreases the perimeter and cost of the solutions, and the overall variability 
of each scenario (cloud of points which represent a run for each scenario,  get closer to each other). 

 
 
 
 
 
 

Scenario 2: BLM: 0.01 

http://doi.org/10.5281/zenodo.3235937
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➢ Boundary Length Modifier (BLM): The key parameter we explored in this calibration 
analysis is the boundary length modifier (BLM), which determines the level of aggregation 
across planning unit boundaries in the solutions. The optimal BLM (i.e. the one that 
minimizes the trade-off between clumping and costs) is the point on the hyperbola where a 
further change in boundary length results in a significant increase in costs. 

 
 

 
Trade-off curve for the cost and perimeter for ten scenarios where we increased the BLM (values 
ranging from 0 to 100). Each coloured cloud of points represents one of the 10 BLM scenarios with 10 
runs each. In this example used to calibrate BLM for the British Columbia case study, you can see how 
an increase in the BLM decreases the perimeter with little or no increase in the cost of the solutions 
until an inflection point is met with a substantial increase in the cost of the solutions. Your BLM value 
should be around this “inflection” point. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Your optimal BLM is around here 
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The Scenarios (Choose three for the prac report) 
 
Note: scenario 3 and 5 are similar, only choose one for the report 
 
You will need to create a folder for each time you create a new Marxan scenario, so you can safely 
edit them. Every time you run a Marxan scenario it will overwrite the folder where that scenario 
is contained! If you make a mistake, you can roll back and re-copy from your master folder. This 
is a crucial practice that will help you avoid making silly mistakes!!! (it’s in bold with three 
exclamation marks…that means it’s an important point). 

 
Before you begin generating scenarios you need to create a folder containing each scenario to avoid 
overwriting them. Make sure to start every new scenario with a new master folder, i.e. for each 
scenario create a copy of your Marxan_Backup folder and rename it to match the scenario of your 
choice, e.g. Scenarios BLM. Then, repeat the previous step and create five sub-folders inside each 
scenario. You should have 15 folders. In Zonae Cogito, you will choose the input data required from 
each scenario folder. Now you are safe to run your scenarios. 
 
You need to choose 3 of the 6 exercises proposed. For each one you will need to create 5 scenarios 
as specified below.  Unless it is specified to change the BLM or the SPF, leave this parameters with 
the following values BLM: 0.3, SPF: 2. I kindly calibrated them for you. If you are interested on how 
the R code works, or would need to use it sometime in the future, please ask me and I will walk you 
through it. 
 
 
Scenarios exercises: 
 

1. Increasing the compactness of our protected area network: As discussed in the lectures, 
and as you experienced directly in the second exercise of the first prac, it is preferable to 
make protected area networks that are compact, i.e. clumped together rather than spaced 
apart. When using Marxan, you can request increased clumping in your resulting 
conservation plan by increasing the Boundary Length Modifier (BLM). This essentially tells 
Marxan to place a lower cost on a solution if the selected areas are well clumped together 
and a higher cost if they are spaced apart. Create five scenarios by increasing the BLM (e.g. 
0, 0.1, 1, 10, 100) and keeping all other parameters constant. Think how and why adjusting 
the BLM impacts on (a) the area of the reserve system chosen by Marxan and (b) the 
feasibility of getting your conservation plan implemented on the ground. Answer the 
following questions: What happens to the cost when I increase the BLM? What happens 
to the spatial arrangement of your planning units (look at your solution) when you 
increase the BLM? You can create two plots, one with the area vs the BLM and/or the other 
with the cost vs the BLM of the “best solution”.  
 

2. Increasing the SPF values to force Marxan to meet all targets. The species penalty factor 
forces Marxan to meet conservation targets by increasing the “score” value of the Marxan 
solutions when missed targets (e.g. we set a 30% for a habitat and the solution only captures 
25%). Ideally, we want all targets to be met, but we can be flexible and lower our 
expectations. Why would we do that? Which could be the benefits of the solution if not 
all targets where 100% met? Based on your answer to this question, choose a range of 
SPFs (e.g. 0.01, 0.1, 0.5, 1, 2) and analyse how these changes affected the targets met 
(missing values) and the overall cost of the solution. You will need to plot “cost” vs SPF 
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and/or “missing values” vs SPF. 
 

3. Accepting that we cannot protect some places: Some places in BC are expensive or 
impossible to protect. Explore how the reserve system chosen by Marxan varies when some 
areas of BC are “locked out” at the start of the analysis. Why might it be necessary in 
practice to lock out certain areas from a reserve selection process? Based on your 
answer to this question, choose 100 planning units to lock out by changing their status to 3 
“locked out” and defend your decision. Choose expensive planning units to simulate 
areas not suitable for conservation. Do that again but increase to 500, 1000, and 1500 
planning units “locked out” (your five scenarios should have 0, 100, 500, 1000, and 1500 
planning units “locked out”). How do the locations of the sites chosen differ from your 
initial analysis where all the marine surface was available for reservation? Why 
might this be? Did the cost of the reserve system change? You will need to plot the of 
each scenario vs the number of planning units you “locked in”. 
 
Tip on how to change pu status for this exercise: Go to your Marxan “input” folder. Open the pu.dat in Excel. 
If it opens with Notepad, close and right click on pu.dat, go to Open with and select Excel. You can also open excel 
and drag pu.dat (make sure you ricght click on the column and then go to data and click “text to columns”, and 
select commas as delimiters). Next left click on the cost column and click on the sort. Now you can see which 
planning units are more expensive, just select the first 100 and change their status to 3. Repeat the same for all 
scenarios.  Finally save as a CSV (Comma delimited) and name “pu2”. Now open with notepad, and save as pu.dat 
and select all types in the “save as type”.  

 
4. Changing targets: You have run your first conservation plan by requiring that 30% of each 

species’ distribution is represented within your protected area network. But what are the 
implications of changing this target? After you copy the database to create a new scenario, 
create a new ZC project and edit your targets in the spec.dat file. Experiment with different 
targets (e.g. 10, 20, 30, 40, 50%). Check if your targets are still being met (In Zonae Cogito 
go to Marxan, view output files, best solution, then report) met and compare with the 30% 
target results. Then experiment with different targets to see how that changes the solutions. 
How and why do your solutions differ with different targets? What happened to the 
cost of your solutions? You can plot here the representation targets vs missing 
representation, or plot representation targets vs cost.  You will need to plot cost vs 
representation targets.  

 

5. Not locking in existing protected areas: Some places in BC might already be protected, 
but what if we start again from scratch and build a totally new protected area system? How 
does this change the distribution of areas that you select for conservation? Explore how the 
reserve system chosen by Marxan varies when existing protected areas are “locked in” or 
not “locked in” at the start of the analysis. Do that by randomly choosing 100 planning units 
and lock them in by changing their status to 2. Repeat this for 500, 1000, and 1500 planning 
units ” (e.g. your five scenarios should have 0, 100, 500, 1000, and 1500 planning units 
“locked in”). How do the locations of the sites chosen differ? Why might this be? Do you 
think it is best as a general rule to lock in the existing reserve system at the start of a 
conservation planning analysis? Why or why not? You will need to plot the cost vs the 
number of planning units that you “locked in”. 

 
 

6. Not including a cost measure: What happens if we don’t use a cost measure in our 
analysis? This can happen in cases where cost data is not available. We might use indirect 
measures of cost to represent it, such as the area of the planning units or the distance from 
ports (the closest a planning unit is to a port, we can assume the fishing pressure will be 
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higher than farther planning units, however this might not be true). Explore how the reserve 
system chosen by Marxan varies when you change your cost column to the area of the 
planning units to 4 (4km2). You can do that in Zonae Cogito. In the “Marxan Parameter To 
Edit” select PU. Then click cost and “Edit All Rows”. Now if you change the cost value for one 
cell, it will change for all planning units. Compare scenarios with cost measure against the 
indirect cost measure. Keep all other parameters constant (BLM, SPF, and targets). How 
and why do your solutions differ with and without a real cost measure? You will need 
to create a bar plot with the cost of the solutions for the two different treatments.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: for all your plots extract the values from the best solution, as described in page (19) 


